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Tutorial: Calculating River Plastic Transport from Visual Counting 

In this tutorial you will work with actual visual counting data to calculate river plastic transport in various 

rivers around the world. The calculation steps can also be used to work with your own data. 

 

Learning outcomes 

The learning outcomes of this practical are: 

1. Calculate plastic transport from visual counting observations 

2. Estimate plastic emission using a conceptual model 

3. Compare the observation-based and model-based emission estimates 

4. Explain the differences between observation-based and model-based estimates for various 

rivers. 

What you need to hand in 

You can write down the answers to the questions, briefly and to the point, in the provided spaces on this 

exercise sheet.  

 

Getting ready 

- Make sure your Excel is set in English. To do this: Set up your Excel in English: File → Option 

→ Language → English; 

- Make sure that the Delimiter set to ‘.’, instead of ‘,’. To do this: File → Option → Advanced → 

Untick “use system separators”; 

- For the tutorial, make sure to at least finish up to the questions in 1.1.2. If that works you’re all 

set for the practical; 

- Work in pairs. 

 

Introduction  

During this practical you will make use of the statistics program Excel. The workout and answers of the 

exercises will also be given. 

In this practical you will estimate annual floating plastic transport in rivers and investigate the relationship 

between plastic transport and discharge. For this practical, you will use observation data. These are:  

(a) Visual counting observations of floating plastic in the Meuse river, Netherlands;  

(b) Visual counting observations of floating plastic in the Odaw river, Ghana;  

(c) Visual counting observations of floating plastic in the Ciliwung river, Indonesia;  

(d) Model inputs for the Meuse, Odaw and Ciliwung rivers from Lebreton et al. (2017) model; 

(e) Discharge data for the Meuse river and for the Odaw river.  
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Part 1: Observations-based estimates of annual plastic transport  

1.1 River Meuse  

Open the Excel file provided and work with the first sheet called ‘Meuse_data’.  

 

Fig. 1. Measurement locations along the Rhine, IJssel, and Meuse rivers. The large symbols represent 

the locations where measurements were done monthly and during the peak discharge events. The small 

symbols represent the locations where three measurements were done between June and December 

2021. Source: van Emmerik et al. (2022).  

1.1.1 Calculate hourly plastic transport (columns N to Q) 

You will calculate the floating plastic transport based on visual counting observations. Observations were 

done at different bridge locations. At each bridge, measurements were done at various segments. First, 

calculate the transport flux per minute (column N) and then per hour (column O). You need to insert a 

formula in the first row of each column and then drag it to the rows below for it to be applied to all the 

data.  

In the bottom right corner of the cell in which you wrote down a formula, you will see a black cross 

appearing. If you double click on it (or drag it down), the formula will be applied to the cells below:  
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Second, calculate the normalized hourly transport per segment (column P). Here you take into account 

the observational width (e.g.: the segment width). You can then extrapolate to the entire river width 

(which corresponds here to the bridge width) (column Q).   

Q: Considering the values you get per bridge segment, why do you think observations are made at 

various segments across bridges?  

 

Q: What would happen if observations were only made at one segment? 

1.1.2 Calculate daily transport rates (columns S to W)  

You will now estimate the daily transport rates per locations. For that, you need to add a column that 

joins the location name and date, as we are ultimately interested in having daily averages per location. 

You can use the following Excel formula to that scope in column S:  

=TEXT(A3, "yyyy-mm-dd") & " - " & E3  

This formula joins the datetime (A column) with the location name (E column). Drag down the formula 

in the next rows to have it applied to the entire table.  
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In the next column (T), select the unique sets of locations and dates across your entire dataset. You can 

use the ‘UNIQUE(S$3:S$1686)’ command in Excel.  

You have now selected the unique dates and locations of plastic sampling. Now you will calculate the 

daily plastic transport averages for all these unique combinations in the next column (column W). You 

can use the AVERAGEIF function in Excel:  

=AVERAGEIF(S:S, T3,Q:Q)  

And then drag down the formula in the next rows.   

This formula takes three main arguments: 

• Range (S): This is the range where Excel looks for values that meet a specified condition or 

criterion (in this case, S:S contains the dates and locations for plastic sampling). 

• Criteria (T3): This specifies what value to look for in the range. Here, T3 holds the unique 

date-location combination for which you want to calculate the average. Excel will search 

through S:S to find cells that match T3.  

• Average range (Q): This is the range of values Excel will average if they meet the criteria 

(i.e., if the date and location in column S match T3). Here, Q:Q contains the plastic transport 

values you want to average for each unique date-location combination. 

Q: Write down here the range of your values (min and max values) and the average you find for the 

entire river Meuse. For this, use the MIN, MAX and AVERAGE functions in Excel. Compare your results 

with that of your neighbors.  

 

Q: What do you think a negative value means?  

 

Q: How many orders of magnitude do you have in your range of values?  NB: An "order of magnitude" 

is a way to describe the scale or size of something, usually using powers of ten. When something differs 

by an order of magnitude, it means it's roughly ten times larger or smaller than something else.  

 

 

 

Min:  

Max:  

 

Mean:  
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1.1.3 Spatial variability along the Meuse river (columns Z to AA) 

Column Z lists unique locations along the Meuse, ordered from upstream (near Belgium) to downstream 

(near the river mouth). Estimate the average annual transport rates for these locations using the 

AVERAGEIF function.  

Q: Plot the data per location. Do you see any considerable differences between the locations?  

 

Q: What could be the cause of that the large differences between Maastricht and the other locations? 

Remove temporarily Maastricht data in column U for the month of July and report what changes in your 

plot.  

 

1.1.4 Annual time-series for two locations along the Meuse river (columns AC to AH)  

For two locations – Ravenstein and Moerdijkbrug – observations were conducted each month, which is 

not the case for other locations. This is why we will now focus on the data from these two locations 

specifically.  

Extract the average transport rates for both these locations over the entire time-series. Plot the monthly 

time-series for these two locations. You can use the Filter option on column V to only see the values for 

Ravenstein and Moerdijkbrug, and then copy paste them, along with the corresponding dates, in 

columns AC, AD, AG, AH. Plots can be added from the ‘Insert’ menu and then by selecting ‘Scatter’ from 

the Chart submenu.  

Q: At which location is the transport rate higher? Provide some hypotheses that could explain these 

results. Tip: look where these two locations are along the Meuse.  

 

Q: Are there clear peaks and trends in the time-series?  
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1.1.5  Annual plastic emissions into the ocean (columns AJ to AK) 

Estimate the mean annual transport rates for Moerdijkbrug, the most downstream location. Given that 

this location is close to the Meuse river mouth, we consider that this is equivalent to emissions into the 

ocean. Provide your estimates in both millions of items/year and tons/year. For the mass transport 

estimate, consider that the average mass of plastic items is 10 g/item.  

 

Q: Report your values below.  

 

Q: What are the sources of uncertainties in these estimates?  

 

Q: Express your values also as per capita values (g/year/person and items/year/person). The Meuse 

river catchment has approximately 9 million inhabitants. Report these values below:  
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1.2 Ciliwung and Odaw rivers  

 

Fig.2. Map of the Odaw catchment with the 10 sampling locations indicated (Source: ESRI Gray) and 

riverbank characteristics in the (b) non-urban riverine zone (locations 1–4) (c) urban riverine zone 

(locations 5–7) (d) urban tidal zone (locations 8–10). (picture credit: Rose Pinto 2021). Source: Pinto et 

al., 2024. 

 

Fig.3. (A) Java, Jakarta and the Java Sea. (B) Overview of monitoring locations and hydrodynamic data 

locations in Jakarta, Indonesia. (1) BKB-Angke (Ciliwung), (2) Cengkareng Kapuk (Pesanggrahan), (3) 

BKT (various), (4) Sunter mouth (Sunter), (5) Cakung mouth (Cakung), (6) BKB-Grogol (Ciliwung), and 

(7) Haryono (Ciliwung). Source: van Emmerik et al., 2019.  
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You will now work with the sheets called ‘Ciliwung_data’ and ‘Odaw_data’. You will reproduce the 

calculations made for the river Meuse for sections 1.1.1, 1.1.2 and 1.1.5. If you lack time, select just one 

of these two rivers. You can ask your classmates what values they found for the other river. The Ciliwung 

catchment has about 5 million inhabitants and the Odaw catchment about 3.4 million inhabitants.  

1.2.1 Ciliwung river (Jakarta, Indonesia) 

Calculate your estimates for annual transport [in millions of items/year and tons/year and per capita] for 

the two given locations of the Ciliwung river (Cenkareng and BKB Angke). We consider that the transport 

for these two downstream locations correspond to plastic emissions into the ocean.  

  

Annual transport at Cenkareng Annual transport at Angke 

items/hour   

Items/year   

millions items/year                                                                     

tonnes/year                                                                 

g/year/person                                                                 

items/year/person                                  
 

Q: How do your values compare to those of the Meuse river? Consider also the number of inhabitants 

and the size of the river system.  

 

1.2.2 Odaw river (Accra, Ghana)  

Q: Do the same calculations for the Odaw river. Report below the range of values you get for daily 

transport, as well as the average transport. What do these values tell you about the system?  

 

 

Min:  

Max:  

 

Mean:  
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Q: Now use only the data for the most downstream location for your emission estimates (Winneba).  

Provide the values you find for the annual emission estimates, in items and mass transport. Reflect on 

how these compare with the Meuse and Ciliwung catchments.  

 

 

 

  

  

Annual transport at Winneba 

items/hour  

Items/year  

millions items/year  

tonnes/year                               

g/year/person                               

items/year/person                                 
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Part 2: Model-based estimates of annual plastic emissions  

In this part of the practical, you will estimate annual plastic emissions using a simple conceptual model, 

from Lebreton et al. (2017). We lack observations for most rivers, therefore model can be useful to 

provide first-order estimates of transport rates for ungauged rivers.  

2.1 First model output calculation  

Open the “Lebreton_model” sheet. The sheet provides monthly data on surface runoff and mismanaged 

plastic waste estimates for the three catchments of interest. Those are your input data for estimated 

annual plastic emissions. Use the formula given in the tutorial lecture to estimate annual plastic 

emissions.  

𝑀𝑜𝑢𝑡 = (𝑘 ∗ 𝑅 ∗ 𝑀𝑃𝑊)𝑎 

Where R stands for surface runoff, MPW for mismanaged plastic waste, and a and k the two model 

parameters. Note that these parameters have no direct physical meaning. However, in general k 

represents the fraction of mismanaged plastic waste entering the environment, and a represents the 

non-linearity in the response of plastic transport to discharge. The first step is to estimate the average 

surface runoff, using the provided monthly values. Ultimately, you want to estimate your output in 

tons/year, so bear in mind the units in your calculation. We provide you with initials k and a values, where 

k = 0.00001 and a = 1.52.  

Q: What initial annual plastic emissions values do you get for the three rivers? Report those.  

 

Q: How do these values compare to the your observation-based estimates (part 1 of the practical)? 

 

Q: What factors can explain the diverging values that you find between the modelled values and the 

observed values?  

 

2.2 Model calibration 

Adjust the coefficients k and a in your model to bring its outputs closer to the observation-based values 

that you found in Part 1 of the practical. Report the optimized values you obtain for k and a. Aim to 

approximate the observed values without spending too much time on fine-tuning; an exact match is not 

necessary. 
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River Odaw Meuse Ciliwung 

k    

a    

 

Q: This results in notably different coefficients, particularly exponents, across the three river systems. 

Aim to identify unique values for k and a that optimize the model for all three systems, and report the 

resulting values for these coefficients. Again, aim to approximate the observed values without spending 

too much time on fine-tuning; an exact match is not necessary. 

 

Q: Reflect on the choice of input variables in the model. Do you think the model assumptions are correct?  

 

Q: What other factors could you consider to estimate plastic emissions into the ocean?   

 

k:  

a:  
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Part 3 Relationship between river discharge and plastic transport rates  

3.1 Discharge and plastic transport for the Meuse river 

In this part of the practical, you will focus again on the Meuse plastic data. In addition to the plastic data, 

we provide river discharge estimates, extracted from Water Info (https://waterinfo.rws.nl/). We coupled 

the discharge and plastic transport estimates at a daily time-scale. Open the sheet called 

“Meuse_plastic_discharge”. The scope of this part of the practical is to formulate your own model for 

estimating plastic transport using discharge as the input value. You can try to do this without further 

instructions or you can follow the step-by-step approach that we provide.  

Q: Plot for the two given locations the river discharge values against the plastic transport rates. How do 

the plot look like? What do they suggest?  

Display on each plots the linear equations that you get for the two locations. It should be in the form of:  

𝑃 = 𝛽 +  𝛼 ⋅  𝑄 

Where P is the plastic transport rate, Q the discharge, β the intercept and α the slope. The intercept 

represents the “base plastic transport” when the discharge is 0, and the slope represents the additional 

plastic transport for a given increase in discharge. 

Q: What intercept values do you get? Do they make sense?  

Force the intercept to be set to zero. For that, click on the scatter plot, “Trendline> More options” and 

check the box “Set intercept”.  

Q: Do you get the same slope (α) values for the two locations?  

 

Q: Add a new column to calculate the correlation coefficient (R2) between discharge and observed 

plastic transport. An R2 value closer to 1 indicates a better fit between the two variables. Use Excel's 

RSQ function for this calculation. What scores do you get?  

 

 

 

 

https://waterinfo.rws.nl/
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Add a new column for which you will model plastic transport based on discharge and the α slope value 

that you found for each system. Additionally, include the R2 value to indicate the goodness of fit between 

the predicted and observed values.   

Q: What do you observe when comparing your modelled values with the observed plastic transport 

values?  

 

Add a new column to propose a new model based on a power-law function. This takes the form of:  

𝑀𝑜𝑢𝑡 = (𝑘 ∗ 𝑄)𝑎 

Where Q is river discharge, k is a coefficient and a the exponent.  

Q: Identify the values of k and a that provide a good fit with the observed plastic transport values. Keep 

in mind that relying solely on R2 can be misleading, as it often emphasizes fit at the extreme values. 

 

3.2 Discharge and plastic transport for the Odaw river 

For some measurement days, flow velocity and water depth were measured during the plastic sampling. 

That enables to estimate river discharge. Use the “Odaw_river_discharge” sheet.  

Q: Plot the river discharge values against the plastic transport rates for a few locations. What do you 

notice?  

 

Q: Why do you think that is the case?  

 

Q: Based on the previous section and this section of the practical, do you think river discharge is a good 

predictor for floating macroplastic transport?  
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Part 4 Riverbank plastic  

4.1 Riverbank concentration 

Open the file “06_Example_riverbank.xlsx”. This file contains measurements of riverbank plastic, and 

other litter, sampled along the Odaw river in Ghana. Below the data entries you can find on overview of 

the locations. You can do your calculations here. 

Q: What are the total sampled mass and items per location? Calculate the mean item concentration, 

plastic item concentration, and mass concentration for each location. Plot the plastic concentration (y-

axis) per location (x-axis). Do you see a trend? Can you explain your results? 

 

 

4.2 Top items on riverbanks 

You can also look at the item distribution, to identify most abundant items per location and in total. 

Q: What are the 10 most abundant items in the Odaw? And per location? Can you explain the results? 
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